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BASIC WEBSITE DESIGN 
Building Web Pages using a Web-Hosting Service with WYSIWYG program 

 
Creating your own website can be a rewarding experience. There are plenty of pros and cons to 
doing it yourself verses hiring it out. If you are thinking about creating a website, “Five Things to 
Consider Before You Start Your Website” is an article available at www.jillkemerer.com and will 
help you make necessary decisions. 
 
This guide provides the basics of designing a website. Before you get started, you should know 
the colors, themes, and layout of your site. You should also know how often you’ll update it. A 
leave alone site will have a different layout than one you update on a regular basis.  By 
determining these items in advance, you can be confident of creating a professional looking 
website on your own. 
 
If you pay attention to details, are good at keeping a schedule, and desire to have control over 
your website, you’re a terrific candidate to do it yourself. 
 
Disclaimer: I am not a professional website designer. I’m just like you and learned from trial 
and error. This guide is not intended to be a definitive website design guide. Use at your own 
risk. Also, most WYSIWYG programs have the same features, but some are more user-friendly 
than others. I recommend Yahoo! Web-Hosting’s Sitebuilder only because I’ve designed two 
sites with it and found it simple to use. Most major web-hosting services offer similar design 
programs at identical prices. Use whichever you’re most comfortable with.  
 
If you use a web-hosting service that doesn’t allow you to download the design program, check 
with the provider to find out how your site appears while you’re designing it. Each change you 
make may show up instantaneously. Obviously, you don’t want this! Choose your plan 
carefully so that you can publish and make changes at your own leisure. 
 
Sign-Up: 
 
When you choose a web-hosting service, you will be asked to register your domain name. If 
you’re using a major service such as Yahoo!, GoDaddy, etc… they will register your name for you 
when you sign up, and they’ll guide you through the process. If you already have a domain 
name, you may need to redirect the name servers to your new web-hosting service. A quick 
Help search will tell you specifics on how to do this.  
 
Once you’ve registered for the plan you want, you’ll be able to download the design 
program onto your computer. The web-hosting service will guide you through these steps and 
it shouldn’t take very long. Some of the less expensive plans do not include easy to use design 
programs. Don’t be afraid to upgrade to get the most user-friendly program. Even the most 
expensive plan is a fraction of the cost you would pay a professional. 
 
When you’ve signed up and have the design program downloaded, you can start creating your 
site. An important thing to know at this point: your website will not show up on the Internet 
until you publish it. You can play around with your site for as long as you want. No one will see it 
until you specifically press “Publish.” 
 
Think of your website as a virtual binder with different sections, except the sections are your 
web pages. 



 2 
 

Before you begin designing, write down the names of the pages you want. Example: Home, 
Biography, Links, Books. You will probably also want a Contact Me e-mail pop-up and a link to 
your existing blog. The web pages you create will be saved as html files.  
 
Part One: Creating the Site 
 

1. Open the design program. At the top is a toolbar, much like any other computer 
program. To create your site, click on File then New Site. Type in the name of your 
website. Mine is www.jillkemerer.com. Some programs have wizards to walk you 
through this. Now you can choose either a template or a blank page. Since, I’m showing 
you how to design a customized website, choose a blank page. 

 
2. A blank page will show up. The tab will be named Index.html. This is your home page. 

Congratulations! You’re now ready to start designing. 
 

Part Two: Site Settings 
 
Whenever you create a web page within your site, I recommend setting the Page Properties first. 
This will maintain a uniform look to all of your pages. 
 

1. Go to Edit and scroll down to Page Properties. This is where you will set important 
behind the scenes information about your site. The first pop-up tab is General. Type in 
the name of your home page under Title. Mine is “Jill Kemerer Home.” When someone 
clicks on your home page, they will read this title in the tab above your site.  
 
Under this will be Description. Type in a brief description of this page. Mine reads: Jill 
Kemerer Home Page. Sweet, Emotional, Sparkling Romance. Jill Kemerer writes 
contemporary romance novels.  Include your name, your brand, and what you write.  
 
Below this is Keywords. Type in the keywords for this page. These are the Meta Tags 
search engines will use to find you. Your name, the genre books you write, and any other 
relevant words found on your home page should be typed in here. 
 
Finally, type in your name under Author. 

 
2. The next tab in the Page Properties box is Fonts. This is where you’ll set the font specifics 

for your site. You can change fonts anywhere when you’re creating or editing, but these 
are the fallback settings. Choose the style font, the size and the colors you’d like the text 
to show up as. If you’re using a light background, select a dark font and vice-versa. These 
settings can be changed at any time, so don’t be afraid to play around with them.  

3. The final tab in the Page Properties box is Layout. This will determine the width, height 
and margins of your site. The default is set to Width: 760, Height: 3000, Left/Right/Top 
Margins: 0, Bottom Margin: 20. These settings determine how your site will show up in a 
browser.  The 760 is narrow and allows a huge portion of your background to be 
displayed. However, if you set this number too high and don’t set the margins, very little 
of your background will show up. I set my site up with these parameters: 

 
Width: 915  Height: 3000 
Left Margin: 30 Right Margin: 30 
Top Margin: 0  Bottom Margin: 20  Centered? Yes. 
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You might not want as much background showing, or you may want the site to be wider 
or narrower, so feel free to play around. You won’t be able to get a good idea of what the 
page looks like until you’ve set one up and previewed it in the browser. The important 
thing is to coordinate all of the web pages in your site with the same settings. Click on the 
Centered box to keep your page centered. 

4. Another great tool is the snap to grid feature. This allows you to keep your elements 
aligned. Go to Arrange at the top of the toolbar. Click on Snap to Grid. You can also show 
the grid and set the grid size if you so desire. 

5. You may have noticed several boxes on your screen. You can collapse these or expand all 
of them if you go to the View pane. Just push on the arrow next to them on your screen. 
The Site Contents will allow you to quickly move to a different webpage; the Preview 
pane will display the page you’re designing. 

 
Part Three: Start Designing 
 
Website design is best thought of in layers. The bottom-most layer will be your background. Lay 
this first—it can always be changed if you don’t like it. The middle layers, wedged between the 
background and top layers, will be blocks of varying colors to denote borders, to type text in, 
etc… The top layers will be text, photos, videos, clip-art, etc… 
 

1. Set a background. This background should be used in every web-page to ensure a unified 
look to your site. You have a variety of options. You can set it a solid color. You can use a 
template from the site. You can use a photo or a background you’ve purchased. There are 
plenty of sites online that offer free backgrounds. Some will require a written credit with 
a link back to their site. Others will allow you to use their backgrounds without crediting 
or linking back to their site. Be sure to read the fine print before downloading any 
backgrounds or images. 
 
a. If you decide to set your background a solid color, go to the Insert tab at the top of 

the toolbar. Click on Background. A pop-up window will display. You can either 
Browse to insert a clip-art or downloaded background, or you can click on 
Background Color to set a solid color. 
 

b. To insert a Background: If you don’t want to use a clip-art or solid background, you 
will need to download to your computer the background you want to use. (You can 
download several and try them out individually, too.) Click on Browse. You will be 
able to select either My Images or Clip Art.  
 
If you’ve downloaded backgrounds, click on My Images. Go to Look in: and find the 
file you downloaded the background into. Click on the file. The file name will show 
up in the original pop-up window. Click Okay. Your background should appear on 
your screen. 
 
If you want to use a clip-art background, in the Browse section, click on Clip-Art. 
Under the Type section, go to Backgrounds. Click on the background you’re 
interested in and hit Okay. The file name will show up in the original pop-up window. 
Click Okay. The background should appear on your screen. If you don’t like this 
background, repeat the process until you find one you like. 
 
If you want to set a solid color, click on Background Color. A pop-up window with 
three tabs will appear. Swatches, HSB, and RSB are the tabs. I’ve found the easiest 
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way to find the color I want is to go to the HSB tab and move the arrow to the color 
group I’m interested in. Then I place my cursor in the range of the big color block. 
This shows the HSB and RSB numbers at the side. When you’ve found the color you 
like, click Okay.  For future reference to the color, you can write down the six-digit 
Hex Color code which appears in Swatches.  
 

2. Adding Middle Layers: 
 
Your background serves as a frame for your site, but it will look plain if you don’t layer 
something on top of it. I recommend layering a color box or boxes. You will also want to 
insert your header on top of this.  
 
Header 

 
Your header is the first thing visitors will see when they go to your site. You want it to 
give important information in a professional looking way. Authors should use their 
name or pen name as the title of their site. Readers type author names into search 
engines, so make it easy on them and display your name front and center. Other 
information to include in your header is your author brand. You may want to include 
a picture or a professional photograph of yourself in your header. 
 
There are a few ways to go about building a header. If you own a program such as 
Photoshop, you can design your own and download the file. You could also hire a 
graphic designer to create one. Or you can build your own using the tools at hand. 
 
If you have a header designed, you can simply insert it by clicking on the Insert an 
Image button in the top toolbar. Go to Look In and find your file. Click Okay and 
move it to where you’d like it to show up. 
 
If you decide to build your own, I recommend a three part process. Use a clip-art bar 
or one you’ve downloaded from another site, a photograph, and insert your title over 
these. 
 
a. Insert a bar. This is the base of your header. Click on Insert Image then Clip-Art. 

Under Type, click on Bars. Scroll through for a bar which resonates with the 
colors and theme of your site. You can change the size of any bar, but you cannot 
change the color. Aim for a horizontally oriented bar. Click Okay when you’ve 
selected one. (Don’t be afraid to repeat this process to find the one you like. Just 
make sure you delete the bars you insert before choosing a new one.)  
 
You can also use a solid color as your bar. An easy way to get a solid color box is 
to use an empty text box. Simply click on the Add Text button in the top toolbar. 
A blue box “Double-click to edit text” will show up. You do not have to type in 
text, but you can fill this box in with color instead. Click on it, then hit the Text 
Background button. The pop-up screen with the color selections will appear. 
Again, you can easily play around with colors in the HSB tab. Once you’ve made 
your selection, click Okay. 
 
Use your cursor to move the bar to the top of the screen. Allow a section of 
background to peek around the bar like a picture frame. (If you set a top margin 
earlier, a portion of background will automatically show through.) 
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When the dotted line moves around the element, in this case the bar, you can 
change the size. Move your cursor to the little boxes around it to either enlarge or 
decrease it. You want the bar to fill up an equal distance from either side of the 
background.  
 

b. Insert a photograph. Click on Insert Image then My Images. Scroll down to find 
the photograph. You will have to download the image you want to use to your 
computer. A great site to find pictures for your website is iStockPhotos.com. 
There are fees and restrictions involved with using their pictures so read the fine 
print if you decide to go this route. Click Okay when you’ve found your picture.  
 
Move the picture either next to your bar or over your bar. 
 

c. Add Title. Click on the Insert Text button. If you do not set a text background 
color, the background will be clear and only the text appears. Move the text box 
up to the bar. Set the parameters of the text box (click on the text box to verify the 
dotted line around it is moving and move your cursor to the small boxes to 
change the size). Set the font, font size, and color of text by using the buttons in 
the toolbar. Type in the title of your site.  
 

Jill Kemerer 
sweet, emotional, sparkling romance 

 
You can use different fonts and different font sizes for your title and your brand. 
Play around to find what pleases you. 
 
  

Solid Color Layer 
 

Below your header (you can put your header over this layer, it’s up to you) you’ll want a 
solid block to put things on. I simply create a text box and fill it in with the color I want. 
Click on Insert Text. Fill in the Text Background color with your color choice (keep this 
light if you plan on using dark text) and resize the box to allow the background to peek 
through on each side (width). You can make this as tall or as short as you want, but this 
will be the second largest element of your web-page and will determine how much of 
your web-page will be seen. If you have little content, you’ll shorten this or a visitor will 
see scads of blank space. I’ll explain this in detail further on. 
 
Navigation Bar or Buttons 

 
Now you have a background with a header over it and a large, empty area to add details. 
The next element to add is your navigation bar (or individual buttons) to get visitors to 
other pages in your site. 
 
You can use clip-art buttons, text boxes filled with color, photos, or even just text. When 
you decide where and what you want to use for buttons, create them (see above on 
adding clip-art image, text box, or photo from add image) and you’ll need to link them to 
pages. You’ll have to create the pages before you can link them. Easy way to do this is by 
going to the File tab, clicking on “Save As,” and saving the current page as a different 
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page in your site. Do this for each page you need. For instance I have “bio.html,” 
“links.html,” “proposals.html,” “articles.html.” You can edit these pages later. 
 
Once your buttons (or text, blank text box, photo, etc…) and other pages are created, you 
can link the navigation buttons.  
  
My buttons are text and I put them to the left of my page like this: 
Home 
About Jill 
Proposals 
Links 
Articles 
Blog 
Contact Jill 
The MVRWA website has them directly underneath the header, horizontal across the top 
of the page.  
To link each button, click on the “Link” button. A pop-up box will appear. The first box 
will ask to link “A page in your site” and if you click on the arrow, you can also choose 
“another website,” “an e-mail address,” or “a file in your computer.” Select “A page in 
your site.” Under this will be a box which you can scroll through to find the correct page. 
Then a box will ask to view in the same window or to view in a new window. If you are 
linking to a page in your site, always select “view in the same window.” Whenever you 
link to another website, including your blog, select “view in a new window.” This will 
assure visitors won’t exit your site if they click on an external link. 
 
Repeat this process for each of your buttons. Try to space the buttons evenly for a unified 
look. 
 
Hint: You can link anything in your site to another webpage. If you want to link a 
portion of your content, simply highlight the text, photo, or whatever you’re linking 
and click the Link button. The pop-up will appear and you can link as above. If you’re 
linking to another website, select “another website,” type in the URL of the site, and 
click “view in a new window.” 
 
If you have a blog, click on the “Link” button, but this time select “Another website.” 
There will be a box within this pop-up to type in the URL of your blog. 
http://jillkemer.blogspot.com. Then select “view in a new window.”  
 
For your Contact Me button, click on the “Link” button, but this time select “an e-mail 
address.” Type in the e-mail address you want mail to go to. You can create an e-mail 
through your website such as jill@jillkemer.com, but you’ll have to go back into your 
web-hosting service online and set the e-mail account before it will work. 
 
Footer 
 
This is what shows up at the very bottom of your page. I recommend typing the text of 
your navigation bar buttons and linking them to your pages so that visitors can jump to 
other pages in your site without scrolling up. Under this, create a thinner version of your 
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header bar, do not include the header picture (if you have one), but do repeat your name 
and brand. 
Under this include a copyright disclaimer. Copyright. 2009. Jill Kemerer. All Rights 
Reserved. 
 
Again, like any of your other elements, you can copy and paste this information to your 
other pages. 
 
Now, you’ve designed the basic layout for each page. This is a good time to copy and 
paste your navigation buttons and your footer to each of the other pages in your site. 
To copy more than one element at a time, press the Control button on your keyboard as 
you select each component. Go to Edit and click on Copy. Open the page you want to add 
the elements to, and go to Edit, and Paste them in. They may show up at a different place 
in your new page, so move them where you want them to show up.  
And if you decide to add new pages later, or you want to redesign your navigation 
buttons, you can always delete the current buttons off all of your pages, create the new 
bar, and copy and paste it to the pages again. 
 
Make sure you go to Page Properties in each new page. Type in the name, description, 
keywords, and author. Set the margins, center the page, and select the font size and 
colors. 
 

3. Adding Top Layers 
 
At this point, you’ve used the majority of the design features in the program. There are 
many bells and whistles I didn’t cover, but you can go through them at your own pace. 
 
You’ll want to add text, pictures, your book covers, and any other content to your pages 
now. Create a text box and size it over your middle blank section so that the text stays 
within the boundaries. Type in as much or as little information as you need. You can 
center, justify, change text color, change background color, bold, italicize, or underline. 
Put as many or as few text boxes in as you’d like. Add photos in between or around the 
text. 
 
When you have the content of your page inserted, check to see how much of that middle 
layer blank section is still displayed. Click on it and use the arrows to shorten it (and any 
additional layers excluding the background) to the edge of the end of your content. This 
ensures your page doesn’t have a ton of blank space when viewed in a browser. 
  
Repeat this process on the other pages in your site. 

 
Part Four: Preview and Publish Your Site 
 
At any point in the design process, you can preview your site if you’re connected to the Internet. 
Simply scroll down to “Preview in Browser” under the File tab. This allows you to see what your 
site will look like when it’s published. Scroll through and carefully scan each page. Verify the 
elements are centered correctly, the navigation buttons show up in the same area in each page, 
your content didn’t accidentally move off the middle blank section, and enough background is 
showing up around the middle layers. 
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When each page looks the way you want it, you’ll have to verify each link. And yes, I want you to 
check that every single link works. It only takes one wrong character to break a link. So when 
you’re in the Preview in Browser, go through each and every page and click on each element in 
your navigation bar. Also check the one in the footer. Every link you create in your content needs 
to be checked, too. 
 
When you’ve checked that each page looks right and all of your links work properly, you are 
ready to publish your site. There’s a big yellow button “Publish.” When you click on it, you’ll be 
prompted to type in your account id and your password. It will verify the URL you are 
publishing to (www.jillkemerer.com) and in less than a minute, your site will be online!  
 
Congratulations! 
 
Updating: 
 
When you update, you will need to be very careful to not accidentally mess up your layout. You 
will have to rearrange elements and lengthen or shorten your blank middle section to 
accommodate different levels of content. If you pay attention to details and preview the pages 
you update in the browser, you can avoid any embarrassing mistakes. 
 
For any updates, I recommend putting your new content in, and if you have to adjust the blank 
middle section, move all of the footer elements also. Once your content is in, readjust the blank 
middle section to the edge of the new content then move the footer close to the bottom. Again, 
preview in the browser and verify any new links.  
 
It’s really easy to accidentally grab an element you didn’t intend to move, so don’t fret if the 
layout suddenly looks funny and you have no idea why. Simply move the element (or resize if 
you accidentally changed the size) back to where it belongs. 
 
Updating is only tricky if you aren’t paying attention. It does not take hours of time, but it does 
take a keen eye. Again, until you Publish the site, the changes you make will not show up online. 
This is nice because you can take your time updating your site and re-publish it when you’re 
ready. For the changes you make to take affect, repeat the Publishing process.  
 
If you want to add a new page at a later date, simply “Save As” one of your pages as your new 
page. Make any changes and don’t forget to update the page properties and add a navigation 
button on each page to link the new one. 
 
The following is a small cheat sheet of often used functions: 
 
Insert Text: Either type in text or use this to create a blank, empty box. You can fill in the 
background with color. 
 Insert Image: You can insert a background, photo, clip-art, or other image with this pop-up 
window. 
Link: This will link whatever you highlight to another webpage, another website, an e-mail 
address, or a file in your computer.  
 
Don’t forget, you simply click on an element to bring the moving dotted line so you can resize it 
or drag it. If you hold Control, you can select more than one element at once to move, copy, or 
cut. 
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Designing your own website does take time. You will have to learn how to use a new computer 
program. You will have to verify each page looks consistent and has the same elements. You’ll 
pick colors, photos, themes, backgrounds, fonts, and everything involved in your site. You’ll 
have to update it and maintain it. 
 
And you’ll feel a wonderful sense of accomplishment when you hit Publish and see your site on 
the Internet. The cost savings are significant and you won’t have to wait for someone else to 
update your site when you have exciting news. If you don’t love your site, you can change it for 
no cost. If you’re worried about your site not looking professional enough, ask your agent or 
editor if they feel it’s appropriate. If they have reservations, ask them specifically what they 
would change. You may be able to tweak it to their specifications without spending wads of cash 
on a professional. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Copyright. 2009. Jill Kemerer. All Rights Reserved 


